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保証

本書に記載した説明は 「現状のまま」

で提供されており、 改訂版では断りな

く 変更される場合があります。 また、

Agilentは、 法律の許す限りにおいて、

本書およびここに記載されているすべ

ての情報に関して、 特定用途への適合

性や市場商品力の黙示的保証に限ら

ず、 一切の明示的保証も黙示的保証も

いたしません。 Agilentは、 本書および

その内容の誤り、 およびその使用に

伴って生じる偶然または必然のいかな

る損害についても、責任を負いません。

Agilentとユーザとの間に別個の書面に

よる契約が存在し、 本書の内容を対象

とする当該契約の保証条件が上記の条

件と矛盾する場合、 別個の契約の保証

条件が適用されるものとします。

テク ノロジー ・ ライセンス 

本書に記載されたハードウエア及びソフ ト

ウエア製品は、ライセンス契約条件に基づき

提供されるものであり、そのライセンス契約

条件の範囲でのみ使用または方製するこ と

ができます。

権利の制限について

米国政府の権利の制限。連邦政府に付与され

るソフ トウェア及びテクニカル・データの権

利には、エンド ・ユーザ・ カスタマに提供さ

れる カ ス タ マの権利だけが含まれます。

Agilentは、本ソフ トウェアおよび技術データ

に関するこの慣習的な商用ラ イセンスを、

FAR 12.211 （技術データ） および12.212 （コン

ピュータ ・ ソフ トウェア）、 および国防総省

に対してはDFARS 252.227-7015 （技術データ  -
商用品目） およびDFARS 227.7202-3 （商用コ

ンピュータ・ソフ トウェアまたはコンピュー

タ ・ ソフ トウェア・ ドキュ メン トに関する権

利） に基づいて提供します。

安全に関する注意事項

注意

注意の表示は、 危険を表します。

ここに示す操作手順や規則などを

正し く 実行または遵守しないと、

製品の損傷または重要なデータの

損失を招く おそれがあります。 指

定された条件を完全に理解し、 そ

れが満たされていることを確認す

るまで、 注意の指示より先に進ま

ないで ください。

警告

警告の表示は、 危険を表します。

ここに示す操作手順や規則などを

正し く 実行または遵守しないと、

怪我または死亡のおそれがありま

す。 指定された条件を完全に理解

し、 それが満たされていることを

確認するまで、 警告の指示より先

に進まないで ください。
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安全記号

測定器およびマニュアルに記載された以下の記号は、 本器を安全に操作

するために守るべき注意事項を示します。

直流 （DC）

交流 （AC）

直流／交流両方

注意、 危険あり （具体的な警告／注意情報については本書

を参照）
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安全に関する注意事項

本器を使用する前に、 以下の内容をお読みください。 本書に記
す説明と手順は、 Agilent モジュラ製品ファ ミ リのすべての測定
器に当てはまります。 安全に関するより具体的な注意事項につ
いては、 お使いのモジュラ製品の 『ユーザーズ ・ ガイ ド』 を参
照して ください。

警告 • デバイスに損傷がある場合は、 使用しないで ください。 デバ
イスを使用する前に、 外装を検査します。 ひびがないか、 プ
ラスチックが欠けていないか調べて ください。

• 爆発の危険性のあるガス、 蒸気、 水分のある環境でデバイス
を使用しないで ください。

• 接続の前に、 デバイスのすべてのマークを確認してください。

• I/O 端子に接続する前に、 デバイスとアプリケーシ ョ ン ・ シ
ステムの電源をオフにして ください。

• デバイスのサービスの際には、 必ず指定された交換部品を使
用して ください。

• カバーが取り外された状態、 またはきちんと固定されていな
い状態でデバイスを使用しないで ください。

• セルフテスト手順を実行する前に、 ターミナル ・ ブロックや
ケーブルを接続しないで ください。

• 思わぬ危険を回避するために、 必ずメーカが供給する電源ア
ダプタを使用して ください。

注意 • デバイスやアクセサリ内部の部品は、 静電放電 （ESD） に
よって損傷を受ける可能性があります。 ESD の発生を防ぐた
めに、 先にケーブルやワイヤをプラグイン ・ コネクタに接続
し、 ケーブル ・ ケースで覆ってから、 出力コネクタに差し込
むようにして く ださい。

• デバイスをメーカの指示どおりに使用しないと、 デバイスの
安全機能が損なわれる可能性があります。

• デバイスの清掃には、 必ず乾いた布を使用して ください。 デ
バイスの清掃にエチル ・ アルコールなどの揮発性の液体を使
用しないで ください。

• デバイスの通気口をふさがないで ください。
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規制マーク

CEマークは、欧州共同体の登録商標

です。 このCEマークは、 製品が関連

するすべての欧州法的指令に適合

することを示します。

C-Tickマークは、オースト ラリアのスペク

ト ラム管理局の登録商標です。 これは、

オースト ラリアのRadio Communication Act
（1992） の条項に基づく EMCフレームワー

ク規制への適合を示します。

ICES/NMB-001は、 このISMデバイス

がカナダのICES-001に適合している

ことを示します。

Cet appareil ISM est confomre a la 

norme NMB-001 du Canada.

本器は、WEEE指指令（2002/96/EC）のマー

キング要件に適合します。 貼付された製

品ラベルは、 本電気／電子製品を家庭ゴ

ミ と して廃棄してはならないことを示し

ます。

CSAマークは、 カナダ規格協会の登

録商標です。

この記号は、 通常使用時に危険物質また

は有害物質が漏れ出すことがないと期待

される期間の長さを示します。 製品の期

待寿命は40年間です。
Agilent USB モジュラ製品／システム クイック ・ スタート ・ ガイ ド V



Waste Electrical and Electronic Equipment （WEEE） 指令2002/96/EC

本器は、 WEEE指令 （2002/96/EC） のマーキング要件に適合します。 貼付

された製品ラベルは、 本電気／電子製品を家庭ゴミ と して廃棄してはな

らないことを示します。 

製品カテゴリ ：

WEEE指令付録1の機器タイプに基づいて、 本器は"Monitoring and Control
Instrument"製品に分類されます。

製品に貼付されるラベルを下に示します。

家庭ゴミ と して廃棄しないこと。

不要になった測定器の回収については、 Agilent計測お客様窓口にお問い

合わせいただ くか、 下記を参照して ください

www.agilent.co.jp/environment/product　

上記のWebサイ トに詳細情報が記載されています。
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Declaration of Conformity (DoC)

この測定器の Declaration of Conformity （DoC） は Agilent Web サイ
トで入手できます。 下記の Web アドレスで、 製品モデルまたは
記述から DoC を検索できます。

http://regulations.corporate.agilent.com/DoC/search.htm

注記 該当する DoC を検索できない場合は、 計測お客様窓口までお問
い合わせください。
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これは空白のページです。
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Agilent USB モジュラ製品／システム

USB モジュラ製品／システムの概要
USBモジュラ製品／システムの概要

USBモジュラ製品／システムには、 さまざまな種類の測定器があ り、 ソ

リ ューシ ョ ン作成の際の選択肢と柔軟性を提供する と と もに、 将来の

ニーズの変化に応じた拡張と進化が可能です。

図 1　USBモジュラ製品／システム ・ ファ ミ リ

USBモジュラ製品の一般的な特長を以下に示します

• Hi-Speed USB 2.0インタフェースを備え、 最高480 MB/sの速度を実

現します。

• 操作にはPCが必要です。

• すぐに測定を開始できるよ うに、 Agilent Measurement Managerソフ

ト ウェアがバンドルされています。

• Agilent Openプログラムをサポート し、さまざまなアプリ ケーシ ョ ン

開発環境 （ADE） で使用できます。

• スタンドアロンの測定器と して使用するこ と も、 Agilent U2781A USB
モジュラ製品シャーシを使用したシステムの構成モジュールと して

使用するこ と もできます （シャーシには最大6台のモジュールを収容

可能）。
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Agilent USBモジュラ製品／システム

USBモジュラ製品／システムの概要
標準付属品

各モジュ ラ製品の標準付属品の一覧については、 当該製品の 『User's
Guide』 を参照して ください。 標準付属品が揃っているかど うか確認し

て ください。 欠けている付属品または損傷している付属品がある場合に

は、 最寄りのAgilent営業所にお問い合わせください。

検査と保守

受入れ検査

USBモジュラ製品を受領したら、 ユニッ トに輸送中に付いた傷がないか

ど うか調べます。損傷が見つかった場合は、最寄りのAgilent営業所に直

ちにご連絡ください。 納品時の梱包は、 購入したUSBモジュ ラ製品を

Agilentに送り返す場合に備えて保管しておいてください。

一般的な保守

1 デバイスの電源をオフにし、 電源コード と I/Oケーブルをデバイスか

ら外します。。

2 デバイスをバンパー ・ ケーシングから取り出します。

3 デバイス上にたまったほこ り を振り落と します。

4 デバイスを乾いた布で拭き、バンパー・ケースを元の位置に戻します。

注記
モジュラ製品のマニュアルで説明していない修理は、 サービスマンのみ

が実施して ください。
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Agilent USB モジュラ製品／システム

インストールと設定
インス トールと設定

USBモジュ ラ製品の準備と インス トールを開始するには、 下のフロー

チャートに示された手順を実行します。

図 2　 インストール／設定のフローチャート

注記 USBモジュラ製品をAgilent VEE Pro、NI LabVIEW、Microsoft® Visual Studio®ソ

フ トウェアとともに使用する場合は、IVI-COMド ライバのインス トールが

必要です。

『A. システムのチェ ック』

『B. Agilent IOライブラリ ・ スイートのインス トール』

『C. モジュール ・ ド ライバのインストール』

『D. Agilent Measurement Managerのインストール』

『E. モジュールのPCへの接続』

『F. モジュール接続の確認』

『G. Agilent Measurement Managerの起動』
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Agilent USBモジュラ製品／システム

A. システムのチェ ック
A. システムのチェ ック

インス トールと設定を行う前に、 使用する PC が以下の最小システム要件を満たしているこ とを確
認して ください。

要件
Windows XPオペレーテ ィ ン

グ ・ システム

Windows Vistaオペレーテ ィ ン

グ ・ システム

Windows 7 オペレーテ ィ ン

グ ・ システム

オ ペ レ ー テ ィ ン

グ ・ システム

Windows XP Service Pack 3
（またはそれ以降）[1]

Windows Vista （32 ビ ッ ト）

Service Pack 1 および 2[2]
Windows 7 （32ビ ッ ト および

64ビッ ト）[3][4]

プロセッサ速度 600 MHz 以上が必要、

800 MHz を推奨

1 GHz 32 ビッ ト （x86） 3 GHz 32ビッ ト （x86）

メモリ 最小256 MB（1 GB以上を推奨） 最小1 GB 最小2 GB

ハードディスクの

空き容量

最小1.5 GB 最小1.5 GB 最小1.5 GB

ビデオ Super VGA （800×600） 256色
以上

DirectX 9グラフ ィ ッ クスのサ

ポート と128 MBのグラフ ィ ッ

クス ・ メモリを推奨[5]

DirectX 9グラフ ィ ッ クスのサ

ポート と128 MBのグラフ ィ ッ

クス ・ メモリを推奨[5]

CD-ROM ド ラ イブ

またはDVD-ROM ド

ライブ[6]

必須 必須 必須

ブラウザ Microsoft Internet Explorer 5.01

以上

Microsoft Internet Explorer 7

以上

Microsoft Internet Explorer 7

以上

[1] サポート される Windows XP のエディシ ョ ン ： Home または Professional

[2] サポート される Windows Vista （32 ビッ ト） のエディション ： Home Basic、 Home Premium、 Business、 Ultimate

[3] サポート される Windows 7 （32 ビッ トおよび 64 ビッ ト） のエディシ ョ ン ： Home Basic、 Home Premium、
Professional、 Enterprise、 Ultimate

[4] Agilent Measurement Manger for Windows 7 の 64 ビッ ト ・サポートは、 WOW64 （Windows-on-Windows 64 ビッ ト） エ
ミュレータ上で動作する 32 ビッ ト ・ アプリケーションという意味です。

[5] SVGA グラフ ィ ックスは、 Windows Vista と Windows 7 でサポート されています。

[6] CD-ROM ドライブと DVD-ROM ドライブのどちらが必要かは、 製品に付属する媒体の種類によって決まります。
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Agilent USB モジュラ製品／システム

A. システムのチェ ック
ソフ トウェア要件 入手方法

IO ライブラリ ・ スイート  15.5 Agilent Automation-Ready CD-ROM に収録

Agilent T&M Toolkit Runtime
バージ ョ ン  2.1

Agilent Measurement Manager ソフ トウェア ・ アプリケーシ ョ ン ・ インス
トーラにバンドル

Agilent T&M Toolkit Redistributable 
Package 2.1 パッチ

Agilent Measurement Manager ソフ トウェア ・ アプリケーシ ョ ン ・ インス
トーラにバンドル

Microsoft .NET Framework
バージ ョ ン 2.0

Agilent Measurement Manager ソフ トウェア ・ アプリケーシ ョ ン ・ インス
トーラにバンドル
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Agilent USBモジュラ製品／システム

B. Agilent IOライブラリ ・ スイートのインス トール
B. Agilent IOライブラリ ・ スイートのインストール

Agilent IOライブラ リ ・ スイート 15.5以上がPCにインス トールされている

場合は、 「C. モジュールド ライバのインス トール」 （24ページ） に進んで

ください。 インス トールされていない場合は、 この手順を実行してIOライ

ブラ リ ・ スイート をインス トールしてください。

1 PCが最小システム要件を満たしているこ とを確認します（「A. システ

ムのチェッ ク」 （14ページ） を参照）。 PC上の他のアプリ ケーシ ョ ン

をすべて閉じ、 Agilent Automation-Ready CD-ROM を準備します。

2 前のバージ ョ ンのIOラ イブラ リ ・スイートから最新バージ ョ ンにアッ

プグレードする場合は、 ソフ ト ウェアをアップグレードする前に、下

に示した測定器と インタフェースを取り外す必要があ り ます。

このステップが必要なのは、 これらのデバイスを IO ライブラ リ ・ ス

イート  で使用するために適切なド ラ イバをインス トールする必要が

あるからです。

i USB測定器をPCから取り外します。

ii Agilent 82357 USB/GPIBインタフェース ・ コンバータをPCから取

り外します。

iii Agilent E8491 IEEE 1394 PC - VXI リ ンク・インタフェースをPCか

ら取り外します。

3 PCの他のすべてのアプリ ケーシ ョ ンを閉じます。

注記 IOライブラリ ・ スイートのConnection Expertのインストールには管理者特

権が必要です。

注記 • IOライブラリ ・スイート をインストールするのと同時にコンピュータ

にPCIカードをインス トールした場合は、 衝突が発生する可能性があ

ります。 インス トールを継続する前に、 PCIカードに対する 「新しい

ハードウェア」 ダイアログを閉じる必要があります。閉じないと、PCI
カードのインストールが終了するまでIOライブラリ ・スイートのイン

ストールが停止します。

• NIソフ トウェア （NI MAXなど） がインストールされている場合は、 IO
ライブラリ ・スイート をインストールする前にすべてのNIサービスを

停止する必要があります。
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Agilent USB モジュラ製品／システム

B. Agilent IO ライブラリ ・ スイートのインストール
4 IOライブラ リ ・スイートが収録されたAgilent Automation-Ready CD-ROM

をPCのCD-ROMドライブに挿入します。

自動実行ウ ィンド ウが自動的に表示されない場合は、

• スタート （Start） >  ファイル名を指定して実行... （Run...） をク リ ッ

ク します。

• <ド ライブ>:\autorun\auto.exeと入力します。 こ こで、 <ド ラ

イブ>はCD-ROMド ラ イブの文字です。

注記 IOライブラリ ・ スイートのインストールはすべて 「フル・ インストール」

です

IOライブラリ ・スイートの以前のバージ ョ ンでは、 IOライブラリをフル・

バージ ョ ンまたはランタイム ・バージ ョ ンと してインス トールするオプ

シ ョ ンがありました。 IOライブラリ ・スイート 14.0以降では、 インストー

ル ・ プロセスはすべてのユーザに対してフル ・ インス トールを提供する

ように変更されました （すなわち、ランタイム・インストール・オプシ ョ

ンはな く なりました） 。 このため、 すべてのインストールに IOライブラ

リ ・ スイート ・ ソフ トウェアの開発用コンポーネン トが含まれ、 独自の

I/Oプログラムの開発が可能になっています。インストールされるソフ ト

ウェアのサイズを最小化するには、 Select Featuresダイアログが表示され

たときにCustomインストールを選択し、 マニュアルとサンプル ・ プログ

ラムの選択を解除します。
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5 インス トール開始ウ ィンド ウが表示されたら、 “Click here to install
now”ボタンを1回ク リ ッ ク し、InstallShield Wizardが表示されるまで

待ちます。

6 IVI共有コンポーネン トおよびIVI VISA COM標準コンポーネン トが

PCにインス トールされていない場合は、 IOラ イブラ リ ・ スイートは

これらをデフォルトの場所にインス トールします。

7 InstallShield Wizardが表示されたら、 Next > をク リ ッ ク してIOライ

ブラ リ ・ スイート ・ ソフ ト ウェアのインス トールを開始します。

8 ライセンス契約を読みます。 条件に同意する場合は、 “I accept the
terms of the license agreement” （ラ イセンス契約の条件に同意しま

す） と書かれたラジオ ・ ボタンをク リ ッ ク し、 Next >をク リ ッ ク して

続行します。

9 InstallShield WizardのSetup Typeダイアログ （図） が表示されたら、

TypicalまたはCustomを選択し、 Next >をク リ ッ ク します。

注記 IOライブラリ ・ スイート  15を使用して、 インタフェースと測定器のイン

ストール、セッ トアップ、設定を簡単に行う方法を説明した、 2分間のビ

デオを見ることもできます。

注記 IVI Shared ComponentsおよびIVI VISA COM Standard Componentsはデフォル

トのフォルダにインストールされます。 IVIコンポーネン ト を別の場所に

インス トールする必要がある場合は、 Agilent IO Libraries Suite Connectivity
Guideの“Custom Installation of IVI Shared Components”を参照して く ださい。
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Typicalセッ ト アップでは、 お使いの構成に対する推奨機能がPCの標

準の場所にインス トールされます。 Typicalセッ ト アップでは、 他の

ベンダのVISA ソフ ト ウェアがPCにインス トールされている場合は、

Agilent VISAがセカンダ リ と してインス トールされます。他のベンダ

のVISAソフ ト ウェアがPC上に見つからない場合は、 Agilent VISAが

プライマ リ と してインス トールされます （Agilent IO Libraries Suite

Connectivity Guideの“Using Agilent VISA in Side-by-Side Mode” も
参照して ください）。

10 Customセッ ト アップを選択した場合は、他のベンダのVISA実装がPC
にインス トールされていなければ、Agilent VISAをプライマ リ VISAと

してインス トールするかど うかを確認する次のダイアログが表示さ

れます。

注記 • “Typical Installation”を選択した場合は、Next >をクリ ックしてステップ13
に進みます。

• “Custom Installation”ラジオ・ボタンを選択した場合は、Next >をクリ ッ

クして、 次のステップ10に進みます。
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他のベンダのVISAがインス トールされている場合は、 同じダイアロ

グが表示されますが、 チェッ ク ・ ボッ クスが選択されていないため、

デフォル ト ではAgilent VISAがセカンダ リ と してインス トールされ

ます。

これに関する詳細については、 Agi lent  IO  Libraries  Sui te

Connectivity Guideの“Using Agilent VISA in Side-by-Side Mode” を
参照して ください。

11 Customセッ トアップを選択した場合は、以下の場所を示すダイアログ

が表示されます。

• IOラ イブラ リ ・ スイートのインス トール先フォルダ

• Agilent VISAのインス トール先フォルダ

• IVIコンポーネン トのインス トール先フォルダ

VISA と IVIのインス トール先フォルダはグレー表示になっていま

す。 これらは参照専用です。 これらを変更するには、『IO Libraries
Suite Connectivity Guide』 の 「Custom Install the IVI Shared
Components」 に記された手順を実行する必要があ り ます。

12 Customセッ ト アップを選択した場合は、 こ こでSelect Featuresダイ

アログが表示されます。

i リ ス ト内の機能をク リ ッ クする と、 機能の説明と、 選択した機能

セッ トに必要なディ スク容量が表示されます。 IOラ イブラ リ ・ ス

イート を使ってプログラムを作成する予定がある場合は、マニュア
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ルとサンプル ・ プログラムをインス トールするこ とをお勧めしま

す、 ディスク容量を節約したい場合は除外するこ と もできます。

ii インス トールする機能のチェッ ク ・ ボッ クスを選択します。 除外

する機能のチェッ ク ・ ボッ クスをク リ アします。 機能を選択した

ら、 Next >をク リ ッ ク します。

13 Start Copying Filesダイアログが表示されます。 Installをク リ ッ ク し

てファ イルのコピーを開始します。

Microsoft .NET Frameworkバージ ョ ン2.0がPCにインス トールされ

ていない場合は、 IOライブラ リ ・ スイートによってそのインス トール

が行われます。 これには最大10分程度かか り ます。 Microsoft .NET
Frameworkは、 IOライブラ リ ・ スイート ・ ユーティ リ ティ、 .NETプ
ログラ ミ ング ・ ツール、および他の多くのアプリ ケーシ ョ ンに必要な

インフラス ト ラ クチャを提供します。 IOラ イブラ リ ・ ス イー ト の削

除、 再インス トール、 アップグレードを行っても、 .NET Framework
のインス トールは最初の1回だけです。

14 ファ イルのコピーが終了する と、 PC を再起動するよ うに求めるダイ

アログが表示される場合があ り ます。 これが表示されるのは、特定の

I/Oハード ウェア構成の場合だけです。 この時点で再起動しない場合

は、 Connection Expertを実行する前に再起動する必要があ り ます。
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15 InstallShield Wizard Completedダイアログが表示され、 IOライブラ

リ ・ スイートが正常にインス トールされたこ とを示します。

i Finishをク リ ッ ク してウ ィンド ウを閉じます。

ii または、 製品／ソ リ ューシ ョ ンの リ ン ク を ク リ ッ ク して、 他の

Agilentソ リ ューシ ョ ンの情報を表示するこ と もできます。

16 右下のWindowsの通知領域にあるIO Controlアイコン （） をク リ ッ ク

して、 IOラ イブラ リ ・ スイート を実行します。

17 IOラ イブラ リ ・ スイート を他の測定器、 インタフェース、 またはソフ

ト ウェア ・ パッケージ （Agilent VEEなど） と と もにインス トールす

る場合は、 追加ソフ ト ウェア （ド ラ イバ、 サンプル ・ プログラムな

ど） を収録した別のCDが用意されている場合があ り ます。 追加ソフ

ト ウェアをインス トールする場合は、 次の手順を実行します。

• PCのCD-ROMド ラ イブにCDを挿入します。

• CD またはハード ウェア／ソフ ト ウェアに付属する手順書に従い

ます。

18 ステップ2でUSB測定器またはE8491 IEEE-1394 FireWire－VXIイン

タフェースを取り外した場合は、 こ こで再接続します。新しいハード

ウェアがある場合はインス トールします。

19 Connection Expertがすでに実行されている場合は、Refresh Allをク リ ッ

クして、 インス トールまたは再接続したハードウェアを識別します。

20 Connection Expertが実行されていない場合は、 ここで実行して、 I/O
構成を確認します。 Windowsの通知領域で、 IOアイコン （ ） を ク

リ ッ ク し、 Agilent Connection Expertをク リ ッ ク します。

i Explorer ウ ィンドウでインタフェースや測定器を見つけます。 ク

リ ッ ク してそのプロパティ を表示します （右側のウ ィ ン ド ウに表

示されます）。右側のウ ィンド ウには状態も表示されます。 インタ

フェースまたは測定器との通信が正常に確立された場合は、 状態

は検証済みとな り、 緑のチェッ ク ・ マークが表示されます。

ii 必要な場合は、 インタフェースまたは測定器のプロパティ ・ ウ ィン

ドウでChange Properties...をク リ ッ クして、デフォルトのI/O構成を変

更します。
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iii 接続を手動でテス トするには、 測定器を選択して右ク リ ッ ク し、

Send Commands To This Instrumentを選択します。

可能な限り、 最新バージ ョ ンのAgilent IOラ イブラ リ ・ スイー ト を使用

して ください。このバージ ョ ンは、最新のインタフェースとオペレーティ

ング ・ システムをサポート し、 最も高度な機能を備えています。 IOライ

ブラ リ ・ スイートの詳細については、

www.agilent.co.jp/find/iolibを参照して ください。

注記 Agilent 488 APIを使用してGPIB測定器をプログラムする場合、 あるいは

NI-488.2互換のプログラムをAgilentインタフェース ・ハードウェア （GPIB
カードなど） で実行する場合は、Agilent 488ライブラリを有効にする必要

がある場合があります。 このためには、 Tools > Agilent 488...をク リ ッ ク

し、 “Enable Agilent GPIB cards for 488 programs” という ラベルのチェ ッ ク ・

ボックスを選択します。

注記 IOライブラリ ・スイートのインストールで問題が発生した場合は、Agilent
IO Libraries Suite Connectivity Guideの“Installation Troubleshooting”を参照して

ください。

UACを無効にしたVistaでのインストール

Windows Vistaオペレーテ ィ ング ・ システムを搭載したシステムで、 IOラ

イブラリ ・ スイートのインス トールで問題が発生する場合は、 ユーザ ・

アカウン ト制御 （UAC） が有効になっている可能性があります。 通常は、

ディ レク ト リ名が正し く ないというエラー・メ ッセージが表示されます。

IOライブラ リ ・ スイート をインス トールする前に、 UACを無効にする必

要があります。
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C. モジュール ・ ド ライバのインストール

1 PCが最小システム要件を満たすことを確認します （ 「A. システムの

チェック」 （14ページ） を参照）。PC上の他のすべてのアプリ ケーシ ョ

ンを閉じ、 Agilent USB Modular Products and Systems Product

Reference DVD-ROMを準備します。

2 Agilent USB Modular Products and Systems Product Reference

DVD-ROMをPCのDVD-ROM ド ラ イブに挿入します。 自動実行ウ ィン

ド ウが表示されるまで数秒間待ちます。

自動実行ウ ィンド ウが自動的に表示されない場合は、

• スタート （Start） >  ファイル名を指定して実行... （Run...） をク リ ッ

ク します。

• <ド ライブ>:\Autorun.exeと入力します。 こ こで、 <ド ライブ>
はDVD-ROMド ラ イブの文字です。

3 インス トール開始ウ ィンド ウが表示されたら、 “Hardware Driver”ボ
タンを1回ク リ ッ クし、InstallShield Wizardが表示されるまで待ちます。

注記 • ド ライバをインストールする前に、 USBモジュラ製品がPCから取り外

されていることを確認して ください。

• IOライブラリ ・ スイート ・ バージ ョ ン15.5以上がインストールされて

いることを確認してから続行して ください。 IOライブラリ ・ スイート

のインス トール手順については、 「B. Agilent IOライブラリ ・ スイート

のインストール」 （16ページ） を参照して ください。
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4 InstallShield Wizardが表示されたら、Next >をク リ ッ ク してモジュー

ル ・ ド ライバのインス トールを開始します。

5 ライセンス契約を読みます。 条件に同意する場合は、 “I accept the
terms of the license agreement” （ラ イセンス契約の条件に同意しま

す） と書かれたラジオ ・ ボタンを選択し、 Next >をク リ ッ ク して続行

します。

6 Readme情報を注意深く読みます。 USBモジュラ製品デバイスがPCか

ら取り外されているこ とを確認します。次に、Next >をク リ ッ クします。

7 InstallShield WizardのSetup Typeダイアログ （図） が表示されたら、

TypicalまたはCustomを選択し、 次に、 Next >をク リ ッ ク します。
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Typicalセッ ト アップでは、 お使いの構成に対する推奨機能がPCの標

準の場所にインス トールされます。

8 Customセッ ト アップを選択した場合は、 こ こでCustom Setupダイア

ログが表示されます。

i リ ス ト内の機能をク リ ッ クする と、 機能の説明と、 選択した機能

セッ トに必要なディ スク容量が表示されます。

ii 除外する機能に対しては、 “This feature will not be available”オプ

シ ョ ンを選択します。 機能を選択したら、 Next >をク リ ッ ク しま

す。

9 Ready to Install the Programダイアログが表示されます。 Installをク

リ ッ ク してファ イルのコピーを開始します。

10 InstallShield Wizard Completedダイアログが表示され、モジュール・

ド ラ イバが正常にインス トールされたら、 Finishをク リ ッ ク してウ ィ

ンド ウを閉じます。

注記 • “Typical Installation”を選択した場合は、 Nextをクリ ックしてステップ9
に進みます。

• “Custom Installation”ラジオ ・ ボタンを選択した場合は、 Nextをクリ ッ

クして、 次のステップ8に進みます。
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1 「C. モジュール・ ド ライバのインス トール」 （24ページ） でモジュール・

ド ラ イバのインス ト ールを実行して、 Agilent Modular Products
Installation Menuがまだ開いている場合は、 ステップ4に進みます。 そ

れ以外の場合は、 次のステップに進みます。

2 PCが最小システム要件を満たしているこ とを確認します （14ページ

の 「A. システムのチェッ ク」 （14ページ） を参照）。 PC上の他のすべ

てのアプ リ ケーシ ョ ンを閉じ、 Agilent USB Modular Products and

Systems Product Reference DVD-ROMを準備します。

3 Agilent USB Modular Products and Systems Product Reference

DVD-ROMをPCのDVD-ROM ド ラ イブに挿入します。 自動実行ウ ィン

ド ウが表示されるまで数秒間待ちます。

自動実行ウ ィンド ウが自動的に表示されない場合は、

• スタート （Start） >  ファイル名を指定して実行... （Run...） をク リ ッ

ク します。

• <ド ライブ>:\Autorun.exeと入力します。 こ こで、 <ド ライブ>
はDVD-ROMド ラ イブの文字です。

4 イ ン ス ト ール開始 ウ ィ ン ド ウ が表示 さ れた ら、 “Measurement
Manager”ボタンを1回ク リ ッ ク し、InstallShield Wizardが表示される

まで待ちます。

注記 IOライブラリ ・スイート ・バージ ョ ン15.5以上がインストールされている

ことを確認してから続行して ください。 IOライブラリ ・ スイートのイン

ス トール手順については、 「B. Agilent IOライブラ リ ・ スイートのインス

トール」 （16ページ） を参照して ください。
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5 イ ン ス ト ール さ れていない必要 ソ フ ト ウ ェ アが あ る 場合は、

InstallShield WizardのSoftware Prerequisiteダイアログが表示され

ます。 OKをク リ ッ ク して、 表示された欠けている必要ソフ ト ウェア

のインス トールを開始します。

画面上の指示に従って、 表示されている前提ソフ ト ウェアをインス

ト ールし ます。 上記のイ ンス ト ールが完了する と、 Measurement
Manager Softwareのインス トールが開始されます。

6 InstallShield Wizardが表示されたら、Next >をク リ ッ クして Measurement
Managerのインス トールを開始します。

7 ライセンス契約を読みます。 条件に同意する場合は、 “I accept the
terms of the license agreement” （ラ イセンス契約の条件に同意しま

す） と書かれたラジオ ・ ボタンを選択し、 Next >をク リ ッ ク して続行

します。

8 Customer Informationフォームに適宜入力し、 Nextをク リ ッ クします。

9 Nextをク リ ッ ク して指定したフォルダにインス トールするか、 Change

をク リ ッ ク して別のフォルダにインス トールします。

10 Ready to Install the Programダイアログが表示されます。 Installをク

リ ッ ク してファ イルのコピーを開始します。

注記
先に進む前に、 モジュラ製品をすべてPCから取り外します。
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11 InstallShield Wizard Completedダイアログが表示され、モジュール・

ド ラ イバが正常にインス トールされたら、 Finishをク リ ッ ク してウ ィ

ンド ウを閉じます。ソフ ト ウェアのシ ョート カッ トがデスク ト ップに

作成されます。

注記
ライセンス ・ マテリアルの使用

お客様がライセンス ・ マテリアルを使用された場合は、 ライセンス条項

にご同意いただいたものとします。 これらの条項にご同意いただけない

場合は、 すべてのライセンス ・ マテリアルを未開封のままお返しいただ

ければ、 全額払い戻しいたします。 ライセンス ・ マテリアルがバンドル

されているか、 別の製品にロード済みである場合は、 未使用の製品全体

を返送していただければ全額払い戻しいたします。
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1 すべてのソフ ト ウェアと ド ライバのインス トールが終了したら、電源

ケーブルをAC/DC電源アダプタに接続します。 AC/DC電源アダプタ

の要件は、 100～240 VAC、 50/60 Hzで、 出力電圧は＋12 VDCです。

2 AC/DC電源アダプタのDC出力プラグをモジュラ製品のリ ア ・ パネル

の電源ジャッ クに挿入します。

3 モジュラ製品をPC上のUSBポートに、 バンドルされたUSBケーブルで

接続します。

4 接続されたユニッ ト を PC が自動的に検出します。 新しいハード ウェ

アの検出ウ ィザードのウ ィンド ウが表示されます。 「はい、 今回のみ

接続します （Yes, this time only） 」 ラジオ ・ ボタンを選択し、 「次へ

（Next）」 をク リ ッ ク して先に進みます。

5 ソフ ト ウェアを自動的にインス トールする（推奨）（Install the software
automatically (Recommended)） を選択し、 次へ （Next） をク リ ッ ク

します。

6 ハードウェア ・ インス トール （Hardware Installation） ウ ィ ンド ウに

警告メ ッセージが表示されます。

警告を注意深く読み、 続行 （Continue Anyway） をク リ ッ ク して、 モ

ジュラ製品のインス トールを続行します。

注記 • 先に進む前に、 Measurement Managerがインストールされていること

を確認して く ださい。 Measurement Managerのインス トール手順の詳

細については、 「D. Agilent Measurement Managerのインス トール」 （27
ページ） を参照して ください。

• 下の図は単なる参考用であり、PCのオペレーティング・システムや接

続したモジュラ製品の種類によっては表示が異なる場合があります。
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7 新しいハードウェアの検出ウィザードの完了 （Found New Hardware
Wizard Completed） ダイアログが表示され、 デバイス ・ ソフ ト ウェア

が正常にインス トールされたら、 完了 （Finish） をク リ ッ ク してウ ィ

ンド ウを閉じます。

8 Assign USB device aliasウ ィンド ウが表示されます。 モジュラ製品が

接続されるたびに、 このダイアログ ・ボッ クスが表示されます。 この

ダイアログをオフにするには、Show this dialogパネルの“Never show
this dialog”オプシ ョ ンを選択し、 OKをク リ ッ ク します。

注記
以後、 同様の警告メ ッセージを表示した く ない場合は、 以下の手順を実

行します。

1 スタート （Start） > コン トロールパネル （Control Panel） をクリ ッ ク

し、 システム （System） アイコンをダブルクリ ックします。

2 ド ライバ （Drivers） パネルのハードウェア （Hardware） タブを選択し、

ド ライバの署名 （Driver Signing） をクリ ッ クします。 ド ライバ署名オ

プシ ョ ン （Driver Signing Options） ダイアログが表示されます。

3 無視 （Ignore） ラジオ ・ ボタンを選択して、 警告メ ッセージを無効に

します。
Agilent USB モジュラ製品／システム クイック ・ スタート ・ ガイ ド 31



Agilent USBモジュラ製品／システム

E. モジュールのPCへの接続
9 U2300Aシ リーズ、 U2500Aシ リーズ、 U2600Aシ リーズ、 U2781A以

外のモジュールの場合は、システムが、接続されているモジュールの

ファームウェア ・ バージ ョ ン ・ チェッ クを実行します。

i モジュールのファームウェア ・ バージ ョ ンがPCにインス トールさ

れているバージ ョ ン と一致する場合は、 ファームウェア ・ ダウン

ロードは実行されません。 これでモジュラ製品を使用できます。

ii モジュールのファームウェア ・ バージ ョ ンがPCにインス トールさ

れているバージ ョ ン と異なる場合は、 以下のメ ッセージ ・ ボッ ク

スが表示されます。 メ ッセージ ・ ボッ クスに表示されるモデル番

号とファームウェア ・ バージ ョ ンは、 PCに接続されたモジュール

に応じて異なり ます。

iii Yes をク リ ッ ク してファームウェアのダウンロードを開始します。

ダウンロードの進捗度を示す以下のメ ッセージ ・ ボッ クスが表示

されます。 メ ッセージ ・ ボッ クスに表示されるモデル番号は、 PC
に接続されたモジュールに応じて異なり ます。
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10 ファームウェアのダウンロード とアップグレードが終了する と、 モ

ジュラ製品が使用可能な状態になり ます。

注意 ファームウェアのダウンロードが終了するまで、USBと電源の接続を

抜かないで ください。 ファームウェアのダウンロードを中断すると、

デバイスが故障するおそれがあります。
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F. モジュール接続の確認

Agilent Connection Expertは、 IO ラ イブラ リ ・ ス イー ト のユーテ ィ リ

ティの1つです。Connection Expertは、接続されている測定器を設定し、

通信を可能にします。 PCに接続されたモジュ ラ製品を自動的に検出で

きます。

1 PCと インス トールされているモジュラ製品に通電します。

2 Connection Expertがすでに実行されている場合は、Refresh Allをク リ ッ

クして、 インス トールまたは再接続したハードウェアを識別します。

3 Connection Expertが実行されていない場合は、 こ こで実行して、 I/O
構成を確認します。 Windowsの通知領域で、 IOアイコン （ ） をク

リ ッ ク し、 Agilent Connection Expertをク リ ッ ク します。

4 メ イン画面が表示される と、 Instrument I/O on this PCウ ィンド ウ

（「エクスプローラ ・ ウ ィンド ウ」 と も呼ぶ） にシステム接続のマップ

が示されます。

注記
下の図は単なる参考用であり、 PCのオペレーティング ・ システムや接続

したUSBモジュラ製品の種類によっては表示が異なる場合があります。
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5 検出 さ れたモジ ュ ラ 製品が、 エ ク ス プ ロ ー ラ ・ ウ ィ ン ド ウ の

Instrument IOに表示されます。

エクスプローラ ・ ウ ィンド ウで特定の測定器を選択する と、測定器の

パラ メータが右側のプロパティ ・ ウ ィンド ウに表示されます。表示さ

れるパラ メータは、 製品のモデル番号、 シ リ アル番号、 VISAアド レ

ス、 GPIBアドレス、 ファームウェア ・ リ ビジ ョ ンなどです。

上の緑のチェッ ク ・マークのアイコンは、 リ スナー・チェッ ク と識別

（*IDN） 問合せが自動的に実行されたこ とを示します。
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6 測定器との接続をすばやく確認するには、 Interactive IOを使用します。

Interactive IOは、測定器と通信するためのソフ ト ウェア ・ユーティ リ

ティであ り、測定器にコマンドを送信して測定器の応答を表示する機

能を備えています。

Connection Expertから Interactive IOを起動するには、 Connection
Expertメニュー ・バーでTools > Interactive IOをク リ ッ クするか、 エク

スプローラ ・ ウ ィンド ウでモジュラ製品を右ク リ ッ ク します。 コンテ

キス ト ・ メニューが表示されます。 Send Commands To This Instrument

を選択します。

7 Interactive IOダイアログが表示されます。 Send & Readをク リ ッ ク し

て、 *IDN?デフォル ト ・ コマン ド を送信し ます。 測定器の応答が、

Instrument Session Historyパネルに表示されます。

8 Connection Expert とモジュラ製品の間の通信に問題がなければ、 測

定器は正し く インス トールされています。
36 Agilent USB モジュラ製品／システム クイック ・ スタート ・ ガイ ド



Agilent USB モジュラ製品／システム

G. Agilent Measurement Manager の起動
G. Agilent Measurement Managerの起動

1 デスク ト ップのMeasurement Manager Softwareアイコンをダブルク

リ ッ クするか、スタート （Start） > すべてのプログラム （All Programs）

> Agilent > Modular Products > Agilent Measurement Manager を選択し

て、 ソフ ト ウェアを起動します。

2 Measurement Managerのよ う こそ画面が表示されます。

3 接続されているモジュラ製品を示したSelect USB Deviceダイアログ

が表示されます。アプリ ケーシ ョ ンを開始するには、モジュラ製品を

選択してOKをク リ ッ ク し、接続を確立します。Available USB Devices
ウ ィ ンド ウに表示されるモデル番号は、 PCに接続されたモジュール

に応じて異なり ます。

4 Measurement Managerは、選択したUSBモジュラ製品に応じて、適切

な測定アプ リ ケーシ ョ ンを起動します。 モジュ ラ製品のアプ リ ケー

注記 IO ControlはPCを起動したときに自動的に立ち上がります。

IO Controlが動作していない状態でMeasurement Managerを起動すると、 PC
に接続されているUSBモジュラ製品との通信に失敗します。 IO Controlを
実行するには、 スタート （Start） > すべてのプログラム （All Programs） >
IO Libraries Suite > Utilities > IO Controlを選択します。

注記
下の図は単なる参考用であり、 PCのオペレーティング ・ システムや接続

したモジュラ製品の種類によっては表示が異なる場合があります。
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シ ョ ン ・ ソ フ ト ウ ェアの詳細については、 Agilent Measurement
Manager Help Fileを参照してください。
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U2781A USBモジュラ製品シャーシは、最大6台のUSBモジュラ ・デバイ

スを収容できるポータブル ・ シャーシです。 USBプラグアンドプレイ ・

インタフェースを備えていて、 USBTMC-USB488.2規格[1] に準拠してい

るので、Measurement Managerソフ ト ウェアと組み合わせてシームレス

に動作できます。

U2781Aシャーシを購入する と、 スター ・ ト リ ガ ・ バス経由のモジュー

ル間の同期機能を追加できます。 U2781Aシャーシの詳細については、

『Agilent U2781A USB モジュラ測定器シャーシ ユーザーズ・ガイ ド』 を

参照して ください

図 3　 PCに接続されたU2781Aシャーシ

シャーシのインストール

モジュールにLマウン ト ・キッ ト をインス トールする必要があ り ます。以

下の手順に従えば、 Lマウン ト ・ キッ ト とモジュールをU2781Aシャーシ

に簡単にインス トールできます。

1 梱包からLマウン ト ・ キッ ト を取り出します。

2 モジュールをバンパー ・ ケーシングから取り出します。

3 プラスねじ ド ライバを使用して、 Lマウン ト ・ キッ ト をモジュールに

固定します。

[1] Microsoft Windows オペレーティング ・ システムのみで使用可能。
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4 モジュールを、 55ピン ・バッ クプレーン ・ コネクタがモジュールの一

番下になるよ うにU2781Aシャーシに挿入します。 詳細については、

「55ピン ・ バッ クプレーン ・ コネク タのピン構成」 （40ページ） を参

照して ください。

5 モジュールを挿入したら、Lマウン ト ・キッ トのねじを締めて、シャー

シへの接続を固定します。

55ピン ・ バックプレーン ・ コネクタのピン構成

55ピン・バッ クプレーン・コネクタは、モジュールをU2781A USBシャー

シのスロ ッ トに挿入する と きに使用します。SSIコネクタのピンの説明に

ついては、 表1を参照して ください。

図 4　 55ピン ・ バックプレーン ・ コネクタのピン構成

GND GND GND GND GND GND GND GND GND GND GND F

NC NC NC NC NC NC NC NC VBUS GND USB_D– E

GND TRIG3 GND TRIG2 GND TRIG1 GND TRIG0 GND GND USB_D+ D

TRIG4 GND TRIG5 GND TRIG6 GND TRIG7 GND +12 V +12 V GND C

nBPUB CLK10M GND STAR_TRIG GA2 GA1 GA0 NC +12 V +12 V +12 V B

NC NC NC NC NC NC NC NC +12 V +12 V +12 V A

11 10 9 8 7 6 5 4 3 2 1
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表 1　 SSIコネクタ ・ ピンの概要

SSIタイ ミング信号 機能

GND　 グランド

NC　 接続なし

VBUS　 USBバス ・ パワーのセンシング入力

USB_D+、 USB_D–　 USB差動ペア

TRIG0～TRIG7　 ト リガ ・ バス

+12 V　 +12 Vのパワー （4 Aの電流で）

nBPUB　 USBバックプレーン入力検出

CLK10M　 10 MHzクロック ・ ソース

STAR_TRIG　 スター ・ ト リガ

GA0、 GA1、 GA2　 ジオグラフ ィ カル ・ アドレス ・ ピン
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ソフ トウェア ・ ド ライバ

IVI-COMド ライバおよびMATLAB DAQアダプタ用のソフ ト ウェア ・ コン

ポーネン ト とアプ リ ケーシ ョ ンは、 Agilent USB Modular Products and

Systems Product Reference DVD-ROM に収録されています。

IVI-COM ド ラ イバは、 IVI-COM環境でテス ト機器をプログラムするため

に使用し ます。 MATLAB DAQアダプタは、 データ収集モジュ ラ製品

（U2300Aシ リーズ、 U2500Aシ リーズ、 U2600Aシ リーズ） をMathWorks
環境で制御するために使用します。

IVI-COMド ライバをインス トールするには

Agilent Modular Products Installation MenuでSoftware Driver > IVI-COM

を選択し、 インス トールする製品シ リーズのチェッ ク ・ ボッ クスを選択

します。 除外する製品シ リーズのチェッ ク ・ ボッ クスをク リ アします。

図 5　Agilent IVI-COM ド ライバ ・ インス トール ・ メニュー
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MATLAB DAQアダプタをインス トールするには

Agilent Modular Products Installation MenuでSoftware Driver > IVI-COM
を選択し、 インス トールする製品シ リーズのチェッ ク ・ ボッ クスを選択

します。 除外する製品シ リーズのチェッ ク ・ ボッ クスをク リ アします。

図 6　Agilent MATLAB DAQ アダプタ ・ インス トール ・ メニュー

注記 • IVI-COM ド ライバをインストールする前に、 IVI共有コンポーネン ト も

インス トールする必要があります。 IVI共有コンポーネン トは次のIVI
Webサイ トにあります。 www.ivifoundation.org

• 必要な場合は、 IVI-COM ド ライバは次のサイ トからダウンロードする

こともできます。 www.agilent.co.jp/find/ivi-com

注記 • これらのデバイスをMATLABで使用するには、 MATLAB と Agilent
ソフ トウェア ・ コンポーネン ト／アプリケーシ ョ ンをインス

トールし、DAQモジュラ製品を接続し、対応するドライバをイン

ストールする必要があります。MATLABのサンプルは以下にあり

ます。

• www.agilent.co.jp/find/matlab_u2300a （U2300AシリーズDAQ用）

• www.agilent.co.jp/find/matlab_u2500a （U2500AシリーズDAQ用）

• www.agilent.co.jp/find/matlab_u2600a （U2600AシリーズDAQ用）
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モジュラ製品の入門用に、Agilent VEE、LabVIEW、Microsoft （C#、C++、
VB7、 VB6） ソフ ト ウェア ・ プラ ッ ト フォーム用のサンプル ・ コードが

付属しています。

サンプル ・ コードを表示するには

Agilent Modular Products Installation MenuでSample Codesを選択し、下

の図に示すよ うに希望のプログラ ミ ング言語のタイプを選択します。

図 7　サンプル ・ コードの表示

注記 • MATLAB DAQアダプタのインストール方法の詳細については、

各製品シ リーズの 『Using the USB Multifunction Data Acquisition
Devices with MATLAB Software Quick Start Guides』を参照して くだ

さい。

• MATLAB ソフ トウェアは、 MATLAB インス トールDVD-ROMまた

はMathWorks Web サイ ト から直接イ ンス ト ールできます。

MATLABまたはMATLABのData Acquisition Toolboxをお持ちでな

い場合は、 次の場所で使用版を請求できます

www.mathworks.com/agilent/daq/tryit.html。
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コマンド ・ ロガーとコード ・ コンバータ

Measurement Managerを使用する と、設定と制御がプログラ ミ ング作業

なしにすばやく簡単に行えます。 作業をさ らに簡素化するには、 コマン

ド ・ ロ ガー機能を使用し て設定コマン ド を記録し、 Agi lent  VEE、

Microsoft Visual Basic、 Microsoft Visual C#、 Microsoft Visual C++コー

ドの断片に簡単に変換できます。

• コマンド ・ ロガー機能を起動するには、 Measurement Managerを起

動し、 Tools > Command Loggerを選択します。
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• ログに記録されたコマンドを他の言語に変換するには： コマンド ・ ロ

ガー ・ ウ ィンド ウで、 File > Convert Command Fileを選択します。

注記 Command Loggerアプリケーシ ョ ンの使用方法の詳細については、 Agilent
Measurement Manager Help Fileを参照して ください。
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デバイス ・ ライセンスのアクテ ィブ化

USBモジュラ製品をオプシ ョ ン付きで購入した場合は、 追加機能を使用

する前にデバイス ・ ラ イセンスをアクティブ化する必要があ り ます。 デ

バイス ・ ラ イセンスをアクティブ化するには、 Measurement Managerの
Software Licensingアプリ ケーシ ョ ンを使用します。

図 8　 Software Licensing アプリケーシ ョ ン

注記 • Agilent USBモジュラ製品をオプシ ョ ン付きで購入しなかった場合は、

この手順を実行する必要はありません。お使いのモジュラ製品で使用

可能なオプシ ョ ンの詳細については、お使いのモジュラ製品の 『ユー

ザーズ ・ ガイ ド』 を参照して ください。

• Agilent Measurement Managerをインストールしたくない場合は、 Software
Licensingのスタン ドアロン ・ インス トーラを使用する必要がありま

す。Agilent Modular Products Installation MenuでSoftware Licensingを選択

し、 画面上の指示に従います。
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• デバ イ ス ・ ラ イ セン ス を ア ク テ ィ ブ化する には、 Measurement
Managerを起動して、 Tools > License Panelを選択します。

• デバイス ・ ラ イセンスを検証するには、 Software Licensingウ ィンド

ウで、 Verify License > Update Licenseをク リ ッ ク します。

注記
有効なデバイス ・ ライセンス ・ キー （*.lic） が必要です。 デバイス ・ ライ

センス ・キーをお持ちでない場合は、 www.agilent.co.jp/find/softwarelicense
でライセンス・キーを取得する必要があります。画面上の指示に従って、

デバイスに対する有効なライセンス ・ キーを取得します。

注記 Software Licensingアプリケーショ ンの使用方法の詳細については、 Agilent
Measurement Manager Help Fileを参照して ください。
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お問い合わせ先

サービス、 保証契約、 技術サポート をご希

望の場合は、以下の電話番号またはファ ッ

クス番号にお問い合わせください。

米国 ：

(TEL) 800 829 4444 (FAX) 800 829 4433

カナダ ：

(TEL) 877 894 4414 (FAX) 800 746 4866

中国 ：

(TEL) 800 810 0189 (FAX) 800 820 2816

ヨーロッパ ：

(TEL) 31 20 547 2111

日本 ：

(TEL) (81) 426 56 7832 (FAX) (81) 426 56 7840

韓国 ：

(TEL) (080) 769 0800 (FAX) (080) 769 0900

ラテン ・ アメ リカ ：

(TEL) (305) 269 7500

台湾 ：

(TEL)0800 047 866 (FAX) 0800 286 331

その他のアジア太平洋諸国 ：

(TEL) (65) 6375 8100 (FAX) (65) 6755 0042

またはAgilentのWebサイ トをご覧ください。

www.agilent.co.jp/find/assist

本書に記載されている製品の仕様と説明は、

予告なしに変更されることがあります。最

新リビジ ョ ンについては、 Agilent Webサイ

ト をご覧ください。
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